
MONTAŽA VIDEO MATERIJALA 

U dosadašnjem dijelu knjige objašnjene su tehnike i principi koji se koriste prilikom snimanja video 

materijala. Međutim, nakon snimanja nalazimo se u situaciji kada imamo puno različitog materijala, 

ponavljajućih snimaka, mutnih kadrova i još mnogo nepotrebnih stvari. Od svega toga potrebno je 

složiti jedan kratak i zanimljiv video uradak. Upravo ćemo o tome govoriti u ovom poglavlju knjige.  

Nekada je proces montaže bio vrlo zahtjevan i realiziran isključivo u profesionalnim filmskim 

studijima, dok je danas situacija posve drugačija. Moguće je snimiti, izmontirati i distribuirati cijeli 

film koristeći isključivo „pametne“ telefone. Digitalizacija video opreme omogućava čak i običnim 

kućnim korisnicima da naprave izvrsne video uratke i osvoje milijune gledatelja na YouTube-u. 

Sama riječ „montaža“  nije usko vezana uz neki određeni program koju služi za obradu video 

materijala, već je to postupak kojim video materijal sa kamere uvlačimo u kompjuter, pregledavamo 

te „režemo“ i slažemo u jednu smislenu cijelinu. Tehnički postupak nije vrlo složen, i premda postoje 

razni programu za video montažu, svi se temelje na istom principu. Bitna stvar prilikom montaže je 

fokusirati se na kreativni dio, odnosno kako i na koji način posložiti sve snimke. Niti najbolji program 

nam neće pomoći da napravimo kvalitetan video, jer to je samo alat kojeg koristimo u cilju realizacije 

naše ideje. 

Ako je film dobro izmontiran prosječan  gledatelj montažu uopće neće primijetiti. To je upravo i cilj, 

jer je potrebno gledateljima što više približiti stvarnost, a ne dekoncentrirati ih lošim rezovima. 

Osnovne principe montaže objasniti ćemo koristeći program Adobe Premiere CS5.5, a za izradu DVD 

menija ćemo koristiti Adobe Encore CS5.5 

Tijek montaže u 10 koraka: 

- Kreiranje projekta na računalu 

- Učitavanje snimljenog materijala u računalo (capturing) 

- Pregledavanje i rezanje (grubi šnit) video materijala 

- Precizno rezanje (fini šnit) video materijala 

- Dodavanje tranzicija  

- Dodavanje efekata 

- Dodavanje grafičkih elemenata te izrada titlova 

- Dodavanje glazbe i uređivanje zvučnih zapisa  

- Exportiranje gotovog video uratka 

- „Authoring“ DVD-a (izrada menija) 

 

Kako bi lakše mogli pratiti objašnjena koja slijede za vas smo pripremili par video isječaka koje 

možete koristiti za vježbu i koji se nalaze ??? (još ćemo vidjet). Isječci su pripremljeni u H.264 formatu 

kako bi zauzimali što manje prostora i kako bi download bio brži. 

 

 



KORAK 1: Kreiranje projekta 

Nakon što ste pokrenuli Adobe Premiere CS5.5, dobili ste početni Welcome prozor. Za kreiranje 

novog projekta kliknite na New Project (vidi sliku 1). 

Zatim odredite format unosa video materijala u računalo (Capture format): 

DV – standardna rezolucija (720 x 576) 

 HDV – high definition rezolucije  

Također, potrebno je odrediti lokaciju na hard disku gdje će projekt biti smješten i dati mu naziv (vidi 

sliku 2).  

Otvorite jedan novi folder posebno za video projekt, te unutar njega je poželjno otvoriti podfoldere 

zbog lakšeg snalaženja. Na prvi pogled to je možda i nepotrebno, ali kasnije je puno lakše snaći se u 

gomili raznih sadržaja koje ćemo koristiti prilikom izrade videa. Preporuka za podfoldere: 

- Snimke („sirovi“ materijal sa kamere) 

- Grafika (različite slike i grafički elementi koje ćemo koristiti) 

- Audio (pozadinska glazba, snimke naratora i sl.) 

- Export (mjesto gdje ćemo exportirati naš završeni video uradak) 

Nakon što ste kreirali projekt, potrebno je unutar njega otvoriti jednu vremensku liniju (sekvencu) u 

kojoj ćete kasnije slagati video isječke (vidi sliku 3). Postoji velik broj različitih formata koji se koriste 

prilikom snimanja. Sve ovisi o tome s kojom ste kamerom snimali. Mi ćemo za primjer odabrati 

standardni SD (standard definition) format koji koristi većina SD kamera i čija je razlučivost 720x526 

te sadrži 25 sličica u sekundi. Odabiremo DV-PAL, Standard 48 kHz. 

Ukoliko ste snimali u drugom formatu, informirajte se na internetu o tome koju je opciju potrebno 

odabrati. 

Sada te dobili radnu površinu (workspace) u Premiere-u (vidi sliku 4). Ona se sastoji od više manjih 

prozora koje je moguće razmještati, povećavati/smanjivati  po želji.  

U gornjem lijevom kutu nalazi se Project prozor koji služi za unos i organizaciju sirovog materijala i 

ostalih resursa.  

Za vježbu: 

Otvorite video projekt te jednu vremensku liniju u formatu DV-PAL, Standard 48 kHz. 

KORAK 2: Unos materijala 

Capturing video snimaka 

Ukoliko koristite kameru koja snima na video kazete, potrebno je napraviti capture materijala. 

Kliknite na padajući izbornik File → Capture (kratica: F5). 

Ako ste kameru spojili pomoću FireWire kabela, možete sa kontrolama koje se nalaze pri dnu capture 

prozora pregledavati i premotavati snimljeni materijal (vidi sliku 5). Pritiskom na crveni gumb, 

započeti ćete proces unosa videa u računalo. 



SAVJET: Ukoliko uključite opciju scene detect u donjem desnom kutu, program će automatski 

razdvojiti video isječke, odnosno za svaki put kada ste pritisnuli REC na kameri dobit ćete poseban 

video isječak. U protivnom ćete dobiti samo jedan isječak koji će dugo trajati i teško će biti pronaći 

željene kadrove. 

Savjetujemo također da odredite tape name i clip name kako bi se kasnije u montaži lakše snalazili. 

Osobito važno ako se snimljen materijal nalazi na više od jedne kazete.  

Proces unosa materijala zaustavljamo pritiskom na gumb stop, ili tipkom Esc. 

Ako vaša kamera koristi hard disk, optički medij ili flash memorijsku karticu za pohranu snimljenih 

video zapisa, pročitajte u uputama o tome kako prebaciti sadržaj na hard disk. 

Unos materijala sa hard diska 

Materijal koji ste procesom capturinga unijeli u računalo, automatski će se pojaviti unutar Project 

prozora. U svim ostalim situacijama potrebno je ručno unijeti (importirati) materijal. Najjednostavniji 

način je da pronađete video isječke na svom hard disku u folderu Snimke unutar našeg foldera 

projekta, te ih na drag-and-drop način prebacite Project prozor. Premiere CS5.5 također sadržava 

Media Browser koji se nalazi u donjem lijevom kutu i koji omogućava pretraživanje sadržaja hard 

diskova i unos materijala u projekt. Isti princip koristite za unos svih ostalih elemenata (grafike, 

fotografija, glazbe i sl.). 

Važno je da na isti način na koji ste organizirali foldere na hard disku, također organizirate foldere 

unutar Project prozora. Jednom kada unesete puno različitih resursa, lakše se snalaziti ako je sve 

organizirano. Klikom na ikonicu New Bin (vidi sliku 6), otvorit ćete nove foldere, imenovati ih te 

također na drag-and-drop način posložiti elemente u pripadajuće foldere. 

Za vježbu: 

Skinite resurse za vježbu sa linka koji se nalazi u uvodu ovog poglavlja. Učitajte ih u projekt. 

 

KORAK 3: Početak montaže (grubi šnit) 

Sada kada ste pripremili i organizirali sve resurse za rad, možete krenuti sa zabavnijim dijelom 

montažerskog posla. Vrijeme je da svoju kreativnost pokažete na djelu. 

Grubi šnit je izraz koji označava prvi korak u montaži. To je vrijeme kada pregledavate sve snimke, 

izabirete kadrove te ih grubo slažete po zamišljenom redosljedu. Postoje dva načina na koje se može 

odraditi: u prozoru Source ili direktno na vremenskoj liniji (timeline). 

Vremenska linija je prozor koji grafički predočava video uradak.  Tu je prikazan redosljed i trajanje 

izrezanih video klipova te tranzicije koje ćete uklopili. U gornjem lijevom kutu vremenske linije nalazi 

se žuti sat koji pokazuje vrijeme na kojem se nalazi vremenski klizač  (crvena crta) koji služi za 

pregledavanje izmontiranih klipova. 

Montažu započinjete dvoklikom na prvi video isječak u Project prozoru. Tada se taj isječak otvara u 

Source prozoru, te ga pomoću vremenskog klizača te play/pause kontrola možete pregledavati. 



SAVJET: većina programa za montažu koristi tipku space kao play/pause kontrolu. Naučiti tu „kraticu“ 

uvelike ubrzava i pojednostavljuje montažerski posao. 

 

Određivanje IN/OUT točaka 

Nakon što ste pregledali video isječak, vrijeme je da odredite dio koji želite ubaciti u vremensku liniju. 

Dovedite vremenski klizač tamo gdje želite da bude početak video isječka, te zatim kliknite na gumb 

Mark In (vidi sliku 8) (kratica I). Isti postupak ponovite za kraj, i kliknite gumb Mark Out (kratica O).  

Sada ste u Source prozoru dobili označen dio isječka koji želite iskoristiti. Na drag-and-drop način 

povucite isječak iz Source monitora, i ubacite ga na vremensku liniju. 

NAPOMENA: Određivanje IN/OUT točaka, te rezanje isječaka u vremenskoj liniji ne utječe na sirovi 

materijal koji se nalazi na hard disku niti ga briše, već ga program virtualno „reže“.  

Na isti način je moguće ubaciti više dijelova jednog video isječka iz Source monitora. U ovom trenutku 

nije važno precizno odrediti početak i kraj, već samo ugrubo dijelove koje želimo montirati i posložiti 

ih željenim redosljedom. 

 

SAVJET: Nakon svakog većeg postupka nemojte zaboraviti pohraniti projekt. To možete učiniti kroz 

padajući izbornik File → Save ili kraticom CTRL + S. Ovaj je korak vrlo važan, i dobro ga je usvojiti 

odmah na početku, jer u slučaju da nestane struja ili se kompjuter „smrzne“ (što se zna desiti češće 

jer je video montaža zahtjevna za procesuiranje), izgubit ćete sve postupke od zadnje pohrane. 

Postupak ubacivanja materijala ponovite za sve isječke koje želite.  

Montaža na vremenskoj liniji – osnovni principi 

Source monitor vam pomaže da bi pregledali i ugrubo odredili dijelove isječaka koje želite imati u 

finalnom uratku. Pravo podešavanje i dotjerivanje se događa na vremenskoj liniji. Nakon što ste 

ubacili par video isječaka, objasnit ćemo osnove korištenja vremenske linije. 

Pregledavanje – sadržaj vremenske linije pregledavate pomicanjem vremenskog klizača, a video se 

prikazuje u Program monitoru (gornji desni prozor). Pozicija klizača u odnosu na vrijeme prikazana je  

žutim satom u gornjem desnom kutu. Format sata je sljedeći: hh:mm:ss:ff (sati:minute:sekune:sličice 

(frameovi)).  

Zumiranje – primijetili ste da su isječci vrlo sitni i teško ih je dalje pregledavati i slagati. Razlog tomu 

je što vidite velik dio vremena (10 minuta), a isječci traju tek 1 minutu. Zumirati/odzumirati možete 

na tri načina (vidi sliku 9): povlačenjem klizača u donjem lijevom kutu, i povlačenjem za rubove 

gornjeg horizontalnog „scrollbara“. Treći način je da držite tipku Alt te vrtite kotačić miša. Gornji 

scrollbar također se koristi za pomicanje lijevo desno dok se nalazite u zumiranom načinu rada. Sada 

imate bolji pregled isječaka (vidi sliku 10). 



Prikaz sličica – svaki isječak sad ima jednu sličicu i lijevom kutu koja je ujedno i njegova početna 

sličica. Zbog bolje preglednosti, uključite prikaz ostalih sličica (vidi sliku 11). Program će ih prikazati 

onoliko koliko prostor dozvoljava. 

Popunjavanje rupe – kada imate prazninu između isječaka, desnim klikom miša na prazninu kliknete 

na Ripple delete te će se desni isječci pomaknuti ulijevo te popuniti rupu (vidi sliku 14).  

Video i audio trake – na početku postoje po tri video i audio trake. Možete ih zamisliti kao slojeve 

koji teku istovremeno. Primjerice ako ste ubacili isječak u gornju traku, donji se isječak neće vidjeti 

sve dok ne istekne gornji. Ako imate audio isječke u više traka, istovremeno ćete čuti više zvukova. 

(vidi sliku 15). Pojedinačne trake možete paliti i gasiti koristeći gumb oko za video trake, i gumb 

zvučnika za audio trake. Strelica pored naziva trake služi za vertikalno proširenje trake. Prazno mjesto 

lijevo od strelice koristi se za zaključavanje/otključavanje trake. Kad je traka zaključana ne možete 

bilo kojim alatom ništa u njoj pomicati niti mijenjati. Moguće je dodati još video i audio traka 

odlaskom u padajući izbornik Sequence → Add tracks. U prozoru koji se otvorio možete odabrati broj 

traka koje želimo dodati te njihovu poziciju u odnosu na postojeće trake. 

Razdvajanje zvuka i slike –video i audio snimak koje ste unijeli u projekt su spojeni u jedan isječak. To 

vidite kada kliknete na video, program automatski  označi audio i obrnuto. Kako bi ih razdvojili 

potrebno je desnim klikom na isječak odabarti Unlink. Sada zvuk i video možete rezati i premještati 

odvojeno.  

NAPOMENA: Ako imamo isječak koji sadržava govor koji je vizualno vidljiv, potrebno je paziti da 

odvajanjem i pomicanjem zvuka i videa ne dođe do desinhronizacije. 

Za vježbu: 

Video isječke koje ste učitali u projekt posložite na vremensku liniju po željenom rasporedu, te obrišite 

zvuk na isječcima 01, 05 i 06. 

 

KORAK 4: Precizno rezanje - fini šnit 

Nakon što ste ubacili sve željene isječke na vremensku liniju vrijeme je da ih precizno posložite, te 

odredite točno trajanje svakog pojedinačnog isječka. U tom postupku koristit ćete se alatima (Tools) 

koji su smješteni u donjem lijevom kutu programa. Za početak ćemo opisati samo osnovne alate.  

Opis i primjena pojedinačnih alata: (vidi sliku 13a)  

Selection tool (kratica V) – služi za označavanje i pomicanje isječaka, – isječke možete pomicati lijevo-

desno na drag-and-drop način. Ukoliko želite pomaknuti više isječaka odjednom, onda ih označite 

(vidi sliku 12), te ih zatim pomičete. Također, pomoću ovog alata možete skraćivati/produžavati 

(trimati) već ubačene video isječke što je vrlo korisno prilikom finog šnita, odnosno preciznog 

podešavanja (vidi sliku 18). 

Track select tool (kratica A) – ovaj alat označava sve video ili audio isječke u određenoj traci, i to od 

mjesta gdje je postavljen nadesno. Ako želite označiti više traka odjednom, onda uz klik miša držite 

tipku Shift.  



Razor tool (kratica C) – koristi se za rezanje isječaka i to na način da alat pozicionirate na točno 

određeno mjesto pojedinog isječka te klikom miša razdvojite taj isječak na dva nova. Moguće je 

također postaviti vremenski klizač na mjesto koje želite odrezati, te onda alatom kliknuti na njega. 

Tako osiguravate da je rez napravljen točno na toj sličici. 

Ripple edit tool (kratica B) – omogućava produžavanje/skraćivanje pojedinog isječka, pri čemu se 

ostali „susjedni“ isječci pomiču lijevo/desno, odnosno ne nestaju kao kada radite trimanje koristeći 

Selection tool. Koristite ga na krajevima isječaka. 

Rolling edit tool (kratica N) – slično kao i prethodni alat, koristi se za produživanje/skraćivanje 

isječaka, ali namijenjen je za korištenje na spojevima dvaju isječaka. Prilikom pomicanja spoja, 

automatski se jedan isječak produžava dok se drugi skraćuje. 

 

Rate stretch tool (kratica X) – služi za ubrzavanje ili usporavanje isječka. Koristi se na isti način kao i 

Selection tool prilikom trimanja, odnosno na krajevima isječka. Ako želite ubrzati/usporiti isječak za 

točno određeno vrijeme, onda desnim klikom miša na odabrani isječak odaberite Speed/Duration. Tu 

možete podešavati trajanje isječka koristeći postotak ili vrijeme. Opcija Reverse Speed će izokrenuti 

isječak tako da će se prikazivati od kraja prema početku. 

Slip tool (kratica Y) – služi za pomicanje IN/OUT točaka. Prije nego što ste ubacili isječak na 

vremensku liniju, odredili ste njegove IN/OUT točke u Source monitoru. Pozicionirajte ovaj alat iznad 

željenog isječka te držeći lijevu tipku miša pomičući lijevo/desno pomičete IN/OUT točke. Trajanje 

isječka ostaje isto. 

Copy, paste, delete – kao i u većini programa, u Premiere-u moguće je  koristici CTRL+C, CTRL+V i 

DELETE tipke za upravljanje isječcima. 

 

Naknadno ubacivanje klipova 

Može se desiti da nakon što ste posložili isječke po određenom redosljedu, želite između dva isječka 

ubaciti još jedan dodatni isječak iz Project prozora. Postoje dva načina: 

1. Umetanje (insert) – u Source monitoru označite IN/OUT točke isječka koji želite ubaciti, 

postavite vremenski klizač na vremenskoj liniji na mjesto gdje želite da bude početak 

ubačenog isječka te kliknite na tipku Insert (vidi sliku 16). Program će automatski napraviti 

rez na tom mjestu, ubaciti isječak te pomaknuti ostale isječke udesno. 

2. Presnimavanje (overwrite) – ponovite isti postupak kao i kod umetanja, samo u ovom slučaju 

pritisnete tipku Overwrite (vidi sliku 17). Sada neće biti reza niti pomicanja isječaka udesno, 

već će se ubačeni isječak smjestiti unutar već postojećeg isječka. Dobivate  isti efekt kao kada 

bi ga ubacili na gornju video traku. 

Za vježbu: 

Precizno odredite trajanje ubačenih isječaka koristeći se gore navedenim alatima. 

KORAK 5: Ubacivanje tranzicija 



Kada ste presložili/ubacili te skratili i produžili isječke na željeni način, odnosno napravili fini šnit, 

vrijeme je da ubacite prijelaze (tranzicije). Popis svih prijelaza nalazi se u prozoru Effects u lijevom 

donjem kutu programa, pod kategorijom Video Transitions (vidi sliku 19). Postoji velik broj različitih 

zanimljivih prijelaza, a mi ćemo za primjer koristiti Cross Dissolve u kategoriji Dissolve (vidi sliku 19.). 

SAVJET: Jedna od najčešćih početničkih grešaka, kako prilikom izrade PowerPoint prezentacija tako i 

prilikom izrade videa, jest koristiti što više raznovrsnih animacija i prijelaza s ciljem poboljšanja svojeg 

uratka. Na kraju sve to izgleda kao gomila nabacanih efekata koji ponekad oduzimaju pažnju i naporni 

su za gledanje. Profesionalnost se vidi upravo u izbjegavanju toga. Pokušajte koristiti jednostavne 

efekte kao što je obično utapanje (dissolve), a ponekad čak i bez toga, kako bi vaš video ostavio bolji 

dojam. 

Prijelaz ubacujete na drag-and-drop način te ga pozicionirate na rez između dva isječka (vidi sliku 20). 

Ponekad će biti nemoguće ubaciti prijelaz točno na rez, zbog toga što jedan od isječaka nema 

određene IN/OUT točke, odnosno ubačen je na vremensku liniju od samog početka. U tom slučaju 

Premiere nema sličice prije njegovog početka koje bi koristio za prijelaz, te tranziciju ubacujete samo 

na jedan isječak (vidi sliku 21). Bez brige, tada će sličice od drugog isječka biti iskorištene i prijelaz će 

izgledati kao svaki drugi.  

Svaki prijelaz ima zadano (defaultno) trajanje od 1 sekunde. Ako ga želite produžiti/skratiti, koristeći 

Selection tool povlačite (rastežete) prijelaz na isti način kao i sa video isječkom (vidi sliku 22). Također 

je moguće odrediti precizno vremensko trajanje. Dvoklikom na prijelaz otvara se prozor Effect 

Controls (vidi sliku 23), i tu pod opcijom Duration možete unijeti željeno trajanje tranzicije. 

Prijelaze brišemo, klikom na njih te tipkom Delete. 

Početak i kraj – pretapanje u crno 

Kada želite početi iz crnog te pretopiti u prvi isječak, te na kraju završiti sa crnom pozadinom, 

tranzicije pozicionirate na početak odnosno kraj isječaka (vidi sliku 24). Isto se odnosi na grafiku, slike 

ili bilo što drugo što smo se nalazi na vremenskoj liniji. 

Ostale korisne tranzicije: 

Dip to Black – prvi isječak se pretapa u crno, te se zatim pojavljuje drugi   

Dip to White – prvi isječak se pretapa u bijelo, te se zatim pojavljuje drugi (koristi se primjerice u 

vijestima, kada je izrezan nečiji govor, i to u trajanju 3-4 sličice) 

Film Dissolve – korisno za pretapanje sa crnom pozadinom zato što radi na puno realističniji način 

nego Cross Dissolve. Prvo nestaju tamniji dijelovi, a zatim pri kraju svijetliji.  

Za vježbu: 

Primijenite tranziciju cross dissolve između isječaka i to u trajanju od 4 sličice. Početak i kraj pretopite 

u crno. 

 

KORAK 6: Ubacivanje efekata 



Iako se ponekad riječi efekt i tranzicija u širokoj publici koriste kao sinonimi, one zapravo označavaju 

dvije različite stvari. Tranzicije, kao što ste već vidjeli u prijašnjem dijelu služe kao prijelazi između dva 

isječka. Efekti upravljaju pojedinačnim isječkom na različite načine. Primjerice, 

povećavanje/smanjivanje slike, prozirnost, upravljanje bojama, zamućivanje itd.  

Osnovni efekti: 

Klikom na bilo koji isječak otvara se prozor Effect controls koji prikazuje osnovne efekte (vidi sliku 26): 

Motion, Opacity i Time Remapping. Svaku od tih kategorija otvarate klikom na strelicu lijevo od 

naziva. Sve promjene koje izvršavate u ovm prozoru možete pratiti na Program monitoru (gornji 

desni prozor). 

Position – omogućava nam pomicanje videa lijevo-desno-gore-dolje pomoću koordinata određenih 

pikselima. Klikom na naziv Motion dobivate mogućnost pomicanja videa pomoću miša unutar 

Program monitora (vidi sliku 27). 

Scale – služi za povećavanje odnosno smanjivanje videa. Broj 100 označava normalnu veličinu, 

povećavanjem videa dobivate efekt zumiranja, ali istovremeno gubite na kvaliteti snimke. 

Rotation – zakretanje/rotiranje videa 

Anchor point – određivanje točke oko koje se dešava rotiranje 

Anti-flicker – kada video sadrži punog sitnih linija ili oštrih rubova, može se desiti da treperi na 

ekranu, i tada se koristi ovaj efekt. Povećanjem broja, smanjuje se treperenje, ali istovremeno slika 

postaje mekanija, odnosno blago mutnija. 

Opacity – kontrola prozirnosti videa, Blend Mode je način na koji će se video utopiti sa onim koji se 

nalazi u traci ispod njega.  

Time Remapping – animacija promjene brzine videa 

Volume – audio efekt koji služi za kontrolu glasnoće audio isječka 

 

Animacija efekata 

Svaki od ovih efekata koji ima malu ikonu štoperice pored sebe moguće je animirati, odnosno 

mjenjati vrijednosti tijekom vremena. Animacija se realizira na principu Keyframeova. Keyframe je 

zapravo jedan frame koji označava promjenu vrijednosti efekta u određenom smjeru. Animacija se 

događa između dva keyframea. 

Da biste animirali određeni efekt potrebno je postaviti vremenski klizač unutar Effect controls 

prozora na željenu „startnu“ poziciju te kliknuti na štopericu (vidi sliku 28). Nakon toga, pomičete 

klizač udesno do željene točke, te mijenjate vrijednosti efekta (primjerice pozicije, vidi sliku 29). Sada 

se video u vremenskom trajanju između dva keyframea pomakno sa početne točke na zadanu 

poziciju (vidi sliku 30). 



Na isti način možete dodati koliko god želite keyframeova. Princip je isti za sve efekte, a također ga 

možete koristi i za animaciju glasnoće zvuka. 

Ako ste slučajno promijenili određeni efekt na način na koji ne želite, uvijek se možete vratiti na 

početak obrnutom strelicom od kazaljke na satu koja se zove Reset i se nalazi u ravnini svakog efekta 

(Motion, Opacity, Volume, vidi sliku 26) 

Napredni video efekti: 

Pored navedenih osnovnih efekata, Premiere sadržava 16 kategorija različitih naprednih video 

efekata. Oni se nalaze u prozoru Effects pod glavnom kategorijom Video Effects (vidi sliku 31). 

Nemoguće je objasniti sve efekte, međutim princip je vrlo sličan kao i u Photoshopu, odnosno bilo 

kojem programu za obradu fotografija. Tu su efekti za podešavanje boja, svjetline, kontrasta, 

zamućivanje slike i slično. Sve je prepušteno vama na maštu i eksperimentiranje. Efekti se također 

ubacuju na drag-and-drop način, te se nakon što su primijenjeni na određeni isječak pojavljuju u 

Effect controls prozoru ispod osnovnih efekata. 

Prijedlozi: 

Pokušajte isprobati Auto Color, Auto Contrast i Auto Levels efekte iz kategorije Adjust koji će 

automatski pokušati popraviti boje i kontrast na vašoj snimci. Automatski ne mora nužno značiti i 

kvalitetno, tako da ćete sami morati procijeniti da li su isti pozitivno doprinijeli izgledu vašeg 

konačnog uratka. 

Za naprednije poznavatelje obrade fotografija i upravljanje bojama općenito, postoji mnogo efekata 

u kategoriji Color Correction i Image Control kao što su RGB Curves, Three Way Color Corrector i slični, 

koji omogućavaju veliku kontrolu nad snimkom.  

Za vježbu: 

Sirove snimke sa većine kamera, pa čak i onih visoko profesionalnih izgledaju relativno blijedo. To 

omogućava veću kontrolu slike u postprodukciji. Prema tome, koristeći efekt Brightness & Contrast iz 

kategorije Color Correction dodajte malo kontrasta snimkama. 

Napomena: prilikom korištenja ovih efekata dolazi do opterećenja procesora u računalu, te se može 

dogoditi da se video neće moći prikazivati u realnom vremenu, odnosno zastajkivati će. Sve  ovisi o 

računalu na kojem se radi montaža. Na vremenskoj liniji postoje Render bars boje koje prikazuju 

stanje u kojem se pojedinačni isječci nalaze (vidi sliku 50). Zelena linija označava da će se video moći 

prikazivati u realnom vremenu, dok žuta i crvena označavaju nemogućnost prikazivanja u realnom 

vremenu. Da bi pregledali snimku u realnom vremenu bez exportiranja potrebno je napraviti 

rendering i to pritiskom na tipku Enter. Pri tome, dio koji želimo izrendati mora biti označen. Za 

označivanje vremenke linije pomoću Work Area Bar vidi KORAK 9: export. 

 

KORAK 7: Ubacivanje grafičkih elemenata i izrada titlova 

Ubacivanje slika i grafičkih resursa: 



Osim što ste u videu koristili sirove snimke sa kamere, također možete ubaciti statične slike sa 

fotoaparata ili interneta. Nakon što ste željenu sliku ili više njih učitali sa hard diska u Project prozor u 

mapu Grafika, možete ih odmah na drag-and-drop način ubaciti direktno u vremensku liniju. Ovdje 

nema potrebe za provlačenje kroz Source monitor, i postavljanje IN/OUT točaka, jer je to samo 

statična slika, te ćete njezino trajanje odrediti na vremenskoj liniji koristeći Selection tool te povlačeći 

rubove slike (vidi korak 4, opis i primjena pojedinačnih alata). 

Prilikom ubacivanja slike na vremensku liniju, vjerojatno će vam se u Program monitoru prikazati 

samo jedan dio slike, i to zbog toga što su slike u principu puno veće rezolucije nego video (720x576). 

Ovaj problem možete riješiti u prozoru Effect controls gdje možete kontrolirati opciju Scale i smanjiti 

sliku na željenu veličinu. Također sliku možete pomicati i animirati na isti način kao i video isječak 

(vidi korak 6, osnovni efekti). 

 

Za napredne korisnike: 

Kako su Premiere i Photoshop programi istog prozvođača Adobe, njihova je integracija vrlo dobro 

realizirana. Primjerice, možete uzeti jednu .psd datoteku izrađenu u Photoshopu i učitati je u 

Premiere. Tada imate opciju učitati svaki layer zasebno, te možete isključiti nepotrebne layere (vidi 

sliku 32). Kasnije možete svaki layer pomicati i animirati zasebno.  

Izrada titlova: 

Kada ste završili sa montiranjem svih isječaka i slika javlja se potreba da ubacite i poneki tekst u video 

uradak. Bez obzira da li je do običan naslov, potpis, ili odjavna špica, realizacija je prilično 

jednostavna. Za izradu novog teksta odlazimo u  File→ New → Title (kratica Ctrl+T). Dimenzije su 

automatski postavljene sukladno sa korištenim video isječcima (vidi sliku 33), te možete dati naziv 

tekstu (prilično bitno zbog lakšeg kasnijeg snalaženja, osobito ako planirate raditi više tekstova). Sada 

se otvorio prozor za izrađivanje teksta (vidi sliku 34). U pozadini se automatski pojavio video, i to ona 

sličica na kojoj se trenutno nalazi vremenski klizač. To olakšava izradu u pozicioniranje teksta ukoliko 

ga planirate staviti preko videa. Mala ikonica u gornjem dijelu prozora (iznad žutog sata), koja 

prikazuje film i oko omogućava da isključite taj pozadinski video, i tada možete dizajnirati tekst na 

crnoj podlozi.  

U lijevom gornjem kutu prozora se nalaze alati koji služe za izrađivanje teksta (vidi sliku 35): 

a) Selection tool – služi za označavanje i pomicanje objekata 

b) Rotation tool – služi za rotiranje objekata 

c) Type tool – služi za ispisivanje teksta, Vertical type tool služi za vertikalno ispisivanje teksta 

d) Area type tool – izrada tekstualnog prozora, slično kao u Wordu, iza čijih rubova tekst ne 

izlazi 

e) Path type tool – sa njime izrađujete vlastitu proizvoljnu krivulju po kojoj će se ravnati tekst 

f) Grupa Pen tool – za izradu raznih krivulja i crteža (isto kao u Photoshopu) 

g) Grupa alata za izradu različitih objekata (pravokutnika, kružnica, crta i sl.) 

Za početak napišite tekst koristeći Type tool, te ga pozicionirajte i stilizirajte po želji. U gornjem dijelu 

prozora možete odabrati font, te podešavati sve ostale opcije vezane uz tekst. Sa desne strane 



postoji također velik broj opcija i podešavanja. Pod opcijom Fill možete odabrati boju teksta i 

prozirnost, te opcijom Shadow uključiti sjene (vidi sliku 36). Potrebno je malo kreativnosti i 

experimentiranja sa opcijama kako biste dobili optimalni rezultat. Ako nemate baš previše vremena, 

možete odabrati neki od gotovih stilova iz kategorije Title Styles (vidi sliku 37). Gotove stilove 

također možete modificirati. Kako bi se odabrani stil primijenio na tekst, on mora biti označen.  

SAVJET: Prilikom izrade teksta važno je dobro razmisliti o tome, da li se odabrani stil/boja uklapa na 

pozadinski video, odnosno da li se slova vide jasno čitati. Kao i sa efektima, poželjno je ne pretjerivati 

sa različitim bojama i fontovima.  

Vrlo je važno imati na umu margine unutar kojih se nalazi tekst (vidi sliku 38). U prozoru za izradu 

teksta postoje dvije margine. Vanjska margina označava prostor unutar kojeg je poželjno da se nalazi 

video. Iako će se video prikazivati i izvan te margine sve do ruba, pojedini monitori znaju „odrezati“ 

dio rubova, pa nitko ne može garantirati da će se taj video uvijek vidjeti u potpunosti. Unutarnja 

margina označava „siguran prostor“ unutar kojega treba biti smješten tekst. Pravilno je jednostavno: 

za najbolje rezultate pridržavajte se zadanih margina. 

Za jednostavnije pozicioniranje teksta, možete koristiti Title Actions u donjem lijevom kutu prozora 

(vidi sliku 39). Opcije u kategoriji Align omogućavaju pozicioniranje dva teksta u odnosu jedan na 

drugog, i možete ih koristiti jedino u slučaju kada su dva ili više tekstova označena. Center opcija služi 

za centriranje teksta u odnosu na cijeli kadar. Opcije Distribute poravnavaju i slažu tri ili više teksta u 

odnosu jedan prema drugima.  

Kada ste gotovi sa izradom teksta, potrebno je ugasiti taj prozor gornjem desnom kutu. Nije potrebno 

ništa pohraniti jer to program automatski odrađuje. Tekst se sada nalazi u Project prozoru, i možete 

ga uvući u vremensku liniju. Ako želite da se prikazuje preko određenog isječka onda ga ubacite na 

traku iznad (vidi sliku 40). Ako ga stavite u ravnini sa ostalim isječcima, ili ako ispod njega nema ništa 

prikazivat će se na crnoj pozadini. Nakon toga primjenjujete tranzicije i određujete mu dužinu.  

Također postoje i gotovi predlošci za natpise. Iz padajućeg izbornika odaberite Window→ Extensions 

→ Resource Central (vidi sliku 67). Zatim odaberite Templates te u 9 kategorija (Corporate, 

Education, Entertainment...) možete pronaći neki od gotovih titlova, te ga skinuti klikom na 

Download ikonu koja se nalazi lijevo od opisa. Naravno, morate biti spojeni na internet. Nakon 

skidanja predložak će se pojaviti u Project prozoru. Dvoklikom na njega možete ga modificirati i 

izmijeniti po želji. 

Za vježbu: 

U Premiere učitajte sliku po želji (rezolucije 2MP ili više), učitajte je u vremensku liniju, te napravite 

animaciju s lijeva na desno. 

Izradite naslov za film, ubacite ga preko prvog videoisječka te primijenite tranziciju po želji. 

 

Izrada odjavne špice: 

Izradite novi titl te ga nazovite odjavna špica. Napišite tekst odjavne špice po redosljedu jedan ispod 

drugoga, ili ga jednostavno kopirajte iz Worda. Zatim otvorite Roll/Crawl Options u gornjem dijelu 

prozora (vidi sliku 41), te odaberite Roll opciju što znači da će tekst automatski teći prema gore.  



Crawl left/right opcije služe za automatsko animiranje teksta lijevo/desno. Također označite Start Off 

Screen i End Off Screen opcije što znači da će tekst doći i nestati izvan ekrana. Sada ste u prozoru za 

izradu teksta dobili scrollbar sa desne strane koji omogućava da pregledavate cijeli tekst od početka 

do dna. Kada ste završili sa izmjenama na tekstu, ubacite odjavnu špicu na vremensku liniju na isti 

način kako ste ubacili prijašnji tekst. Brzina kojom teku slova određena je vremenskim trajanjem 

odjavne špice. Ako je želite usporiti/ubrzati, potrebno je produžiti/skratiti isječak odjavne špice 

koristeći Selection tool te povlačeći na rubovima.  

Za vježbu: 

Izradite odjavnu špicu u trajanju od 10 sekundi te je ubacite na kraj filma. 

 

KORAK 8: Dodavanje glazbe i uređivanje zvučnih zapisa 

Često puta se kaže da je glazba 50% svakog filma. U tome ima puno istine, zato što glazba 

upotpunjuje ono što vidimo i pojačava doživljaj. Prilikom odabira glazbe koju ćete koristiti u svom 

videu važno je razmisliti o tome što video prikazuje, te kakve osjećaje želite izazvati kod gledatelja i u 

sukladno tome odabrati glazbenu pozadinu. Također je poželjno razmisliti o dodavanju specijalnih 

zvučnih efekata, npr. zvuk otvaranja vrata, kiša, vjetar i slično ako se to uklapa u video. Glazbu uvijek 

ubacujete u zasebnu audio traku od govora, kako bi je mogli lakše kontrolirati (vidi sliku 43).  

Audio prijelazi: 

Zvučni prijelazi funkcioniraju na isti način kao i video, samo što se koriste u audio trakama. Nalaze se 

u kategoriji Audio Transitions u Effect prozoru (vidi sliku 25). 

Constant gain – koristi se na početku audio isječka, te on postepeno pojačava glasnoću 

Constant power – koristi se na kraju audio isječka, te on postepeno stišava glasnoću 

Exponential fade – koristi se na prijelazu između dva audio isječka kako bi pretopio zvukove 

Animiranje glasnoće zvuka: 

Osim što na audio isječcima odnosno glazbi možete primjenjivati audio prijelaze, postoji jednostavan 

način kontroliranja i animiranja glasnoće zvuka direktno na vremenskoj liniji. Za početak je dobro 

proširiti traku na kojoj ćete raditi zbog bolje preglednosti i preciznosti (vidi sliku 44). Kroz sredinu 

svakog audio isječka prolazi jedna žuta crta, koja označava razinu glasnoće. Dok držimo tipku Ctrl te 

istovremeno kliknemo negdje na tu crtu pojavit će nam se mala točka, odnosno keyframe. Potrebno 

je napraviti više takvih keyframeova (vidi sliku 45). Sada možete mišem pomicati svaki keyframe 

gore/dolje – za mijenjanje glasnoće, te lijevo/desno za pomicanje njegove vremenske pozicije (vidi 

sliku 46). Efekat je isti kao kada bi radili u Effects control prozoru, samo što je brži i jednostavniji. Ovaj 

način se primjenuje prilikom podešavanje glasnoće bilo kojeg audio isječka, govora i slično. 

Trenutnu glasnoću možete pratiti u Audio Master Meters monitoru koji se nalazi sa desne strane 

programa (vidi sliku 47). Zvuk ne smije prelaziti u crveno područje, odnosno preko 0dB, a poželjno je 

da uvijek bude ispod -1dB. 



Važno je približno ujednačiti razinu svih audio isječaka i glazbene podloge u tako da gledatelj ne mora 

konstantno pojačavati i smanjivati glasnoću svojih zvučnika. Također, ako stavljate glazbenu pozadinu 

kao podlogu nečijem govoru, bitno je smanjiti je do tog nivoa da se govor može normalno razumjeti 

bez naprezanja. 

Podešavanje zvuka pomoću Audio Mixera: 

U gornjem dijelu programa gdje se nalazi Source monitor, i Effects control prozor, također postoji i 

Audio Mixer prozor (vidi sliku 48). U njemo možete kontrolirati razinu glasnoće za svaku audio traku 

pojedinačno te Master odnosno finalnu razinu. Također možete podešavati odnosno balasnirati zvuk 

na lijevi ili desni kanal pomoću kotačića pri vrhu. 

Audio efekti: 

U prozoru Effects u lijevom donjem dijelu programa u kategoriji Audio Effects nalaze se različiti efekti 

koje možemo primijeniti na audio isječke (vidi sliku 49). Objašnjavanje pojedinačnih efekata, posebna 

je tema i teško je to ukratko opisati. Također, za one malo naprednije korisnike, preporuka je koristiti 

Adobe Audition, program specijaliziran za obradu zvuka u kojemu je moguće puno kvalitetnije i lakše 

obraditi zvuk. Integracija sa Premiere-om jer također vrlo jednostavna, te ako imamo instaliran 

Audition CS5.5 na računalu potrebno je desnim klikom na audio isječak odabrati Edit Clip In Adobe 

Audition što će zatim automatski otvoriti Audition i učitati isječak u njega. 

Korisni jednostavni efekti: 

Balance – služi za balansiranje isječka na lijevi/desni kanal 

Channel Volume – određivanje razine glasnoće za lijevi i desni kanal zasebno 

Fill Left – uzima audio sa lijevog kanala te ga primijenjuje na desni 

Fill Right – uzima audio sa desnog kanala te ga primijenjuje na lijevi 

Zadnja dva efekta su prilično korisna ako ste primjerice snimali intervju sa vanjskim mikrofonom koji 

je snimao na jedan kanal, dok je na drugi kanal snimao integrirani mikrofon u kameri. Integrirani 

mikrofon u principu snima jako široko i ulovi jako puno šumova koji nisu poželjni. U tom slučaju 

primijenite  jedan od dva navedena efekta, kako bi uzeli samo bolji zvuk. 

Kada radite prijelaz sa jednog kadra na drugi, poželjno je da se prvo čuje zvuk sljedećeg kadra, a tek 

onda dolazi video. Vrijeme „najavljivanja“ sljedećeg kadra sa zvukom je kratko, oko 1s, ali je vrlo 

efektno i puno bolje izgleda. Takav način montaže prisutan je u svim profesionalnim filmovima, 

posebno kada se radi o dijalogu. Potrebno je razdvojiti video i zvuk drugog isječka, pomaknuti zvuk u 

traku ispod, te ga produžiti s lijeva za otprilike 1s tako da dobijete rezultat kao na slici 68. Važno je 

paziti da ne pomičete zvuk (kako ne bi došlo do desinhronizacije), već da ga samo produžite. 

Gdje pronaći glazbu? 

Mnogi se suočavaju sa problemom pronalaženja glazbe za svoj film. Najlakše je skinuti neku pjesmu 

sa YouTube-a, međutim teško je za nju dobiti prava. Postoje razni online servisi odnosno „knjižnice“ 

pod nazivom „royalty free“ što znači da pjesmu možete kupiti tek za nekoliko dolara i dobiti prava za 

korištenje. Primjerice: http://audiojungle.net/, http://www.neosounds.com/, 



http://www.premiumbeat.com/ i slični. Međutim za one malo plićeg džepa postoji i drugo rješenje. 

Vimeo Music Store (https://vimeo.com/musicstore) osim pjesama koje naplaćuje, nudi i velik izbor 

besplatnih pjesama pod CreativeCommons licencama. Tražilica je vrlo razvijena i može se naći 

pjesama iz raznih žanrova, štimunga, i tempa. 

Za vježbu: 

Pojačajte zvuk isječka 02 za 5 dB. Pronađite besplatnu pjesmu na Vimeo Music Store-u, podvucite je 

ispod filma, te smanjite glasnoću ispod isječka 02. Također napravite postepeno pojačavanje na 

početku  i stišavanje na kraju.Pripazite da se ne osjeti promjena u zvuku prilikom promjene kadrova. 

KORAK 9: Exportiranje 

Kad ste završili sa montažom, ubacili slike, dodali glazbu i sve lijepo posložili, vrijeme je da gotov 

uradak exportirate iz Premiere-a u jednu finalnu datoteku kako bi je mogli distribuirati. Vjerojatno 

ćete prije ili kasnije svoj video željeti postaviti na YouTube ili neki drugi od mnogobrojnih internet 

video portala. Ili ćete željeti snimiti DVD za svoje prijatelje. 

Prvo je potrebno označiti dio vremenske linije koji želite exportirati pomoću Work Area Bar-a (vidi 

sliku 51). Povlačite rubove Work Area Bar-a na početak i kraj izmontiranih isječaka. Prelaskom miša 

bilo gdje nad Work Area Bar-om, dobivate informacije o početnoj i krajnoj točci te o ukupnoj dužini 

svih isječaka odnosno finalnog videa (vidi sliku 52). 

Zatim odabirete File→ Export → Media (kratica Ctrl+M), i otvara se Export Settings prozor (vidi sliku 

53). Objasniti ćemo postavke za dva trenutno najpopularnija formata. 

H.264 – najkorišteniji format za distribuciju videa preko interneta i općenito. Popularan zbog toga što 

daje izuzetnu kvalitetu videa dok istovremeno zauzima manje prostora nego drugi formati. U 

padajućem izborniku Format odabirete H.264, a za Preset odabirete Pal DV High Quality - vidi sliku 

54 (ako ste radili projekt u drugoj rezoluciji potrebno je odabrati pripadajući preset, 720p ili 1080p 

HD rezolucije ovisno o tome u kojem je formatu sniman izvorni materijal). U opciji Output Name 

potrebno je kliknuti na Sequence 01.mp4, te odabrati mjesto na hard disku gdje želimo da se video 

exportira, te upisati njegovo ime.  

SAVJET: Na početku smo rekli da unutar foldera projekta napravite jedan folder Export, u kojeg ćete 

expotirati gotovi video. Međutim, ako na računalu postoji više fizičkih hard diskova, preporuka je da 

trenutno odaberete neki drugi hard disk - različit od onog na kojem se nalaze svi izvorni resursi – te 

na njega exportirate video. Zatim ćete ga jednostavno kopirati u Export folder. Rezultat će biti brži 

proces exportiranja, zato što računalo neće morati istovremeno čitati i pisati po istom hard disku. 

U video panelu promijenite Field Order u None (progressive), Bitrate Encoding u CBR, te Bitrate 

postavite negdje oko 7 Mbps (vidi sliku 55). Bitrate je zapravo ono što određuje kvalitetu videa, te 

označava koliko će se megabita dodijeliti svakoj sekundi videa. Pri dnu pod Estimated File Size 

možete vidjeti približno koliko će exportirani video biti velik. 

U audio panelu podignite Bitrate na 320 kbps radi bolje kvalitete zvuka (vidi sliku 56). 

Sada možete pritisnuti na Export, i preporuka je da ne radite ništa drugo na računalu dok se proces 

exportiranja ne završi. Opcija Queue otvara program Adobe Media Encoder te u njega učitava cijeli 



projekt. To nam omogućava da učitamo više projekata u Encoder te pokrenemo exportiranje koje će 

automatski nastaviti sljedeći projekt nakon završetka prvog. 

MPEG2 – format koji se koristi za distribuciju videa putem DVD-a, prilikom authoringa (izrade 

menija). 

Za vježbu: 

Exportirajte film u formatu prikladnom za upload na YouTube. 

Gdje distribuirati?  

Osim YouTube-a, također popularan servis za prikazivanje kratkih filmova je Vimeo 

(www.vimeo.com/). Iako je količina videa tamo deleko manja nego na YouTube-u, fokus je na 

kvalitetnijim filmovima i na filmskoj zajednici. To nije mjesto za raznorazne smiješne snimke sa 

mobitela, niti za programe sa televizija za koje ne postoji copyright, a s druge strane odlično je mjesto 

za promovirati svoje uratke, i dobiti inspiraciju od drugih. 

Korak 10: Authoring – izrada menija 

Kako bi se DVD, osim na kompjuteru, mogao prikazivati i na standardnim DVD playerima, potrebno je 

napraviti authoring. To je proces koji obuhvaća formatiranje videa u standardni DVD format, te 

proizvoljno ubacivanje menija odnosno izbornika. Za authoring je najjednostavnije koristiti program  

Adobe Encore zbog odlične integracije sa Premiere-om. Ne morate prvo exportirati video na hard 

disk, već ga možete poslati direktno u Encore. U ovom slučaju ne koristite Work Area Bar, već morate 

izmontirane isječke pomaknuti skroz na početak vremenske linije. Zatim odabirete File→ Adobe 

Dynamic Link → Send to Encore. Automatski se otvara Adobe Encore i New Project prozor (vidi sliku 

57). Potrebno je napisati ime projekta, odabrati lokaciju na hard disku (preporuka je unutar foldera 

projekta napraviti folder Authoring te unutra smjestiti Encore projekt), te odabrati PAL standard.  

Otvara se korisničko sučelje programa Encore, koje je dosta slično Premiere-u. U gornjem lijevom 

kutu imamo Project prozor, zatim Monitor u sredini i vremensku liniju dolje. 

Izrada menija skroz od početka prilično je složen proces, te je zbog toga najjednostavnije uzeti jedan 

gotov predložak te ga izmijeniti i prilagoditi svojim potrebama. U donjem desnom kutu programa 

nalazi se prozor Resource Central. On omogućava skidanje gotovih predložaka sa interneta. Unutar 

njega odaberite panel Menus, te možete odabrati kategoriju Corporate, Education,  Entertainment... 

onu koju mislite da najviše odgovara temi vašeg videa. Kada ste pronašli dizajn približan onome kakav 

biste željeli (napomena: sve se kasnije može mijenjati u Photoshopu) kliknite na download tipku 

lijevo od opisa (vidi sliku 58). Primijetite da pored naziva pojedinog menija piše HD, SD NTSC ili SD 

PAL. Vi odabirete SD PAL verziju. 

Nakon skidanja s interneta, predložak se automatski učitao u program. Prvo možete dizajn prilagoditi 

svojim potrebama. Kliknite na PS (Photoshop) ikonu u gornjem lijevom kutu (vidi sliku 59). Otvara  se 

Photoshop, te u njemu možete napraviti sve grafičke izmjene koje želite. 

Napomena: Nemojte dirati strukturu foldera i layera u Photoshopu, te mjenjati i brisati nazive layera 

kao što su (+) ili (=1), niti uključivati nevidljive layere. Sve je podešeno i prilagođeno za Encore, te u 

suprotnom neće raditi. 



Ako niste prijatelji sa Photoshopom preporuka je da samo izmijenite naslove postojećeg predloška u 

Encore-u, koristeći Text Tool u gornjem lijevom kutu programa. 

Kad ste gotovi sa grafičkim redizajnom u Photoshopu, stisnite Ctrl+S za pohranu, te pri povratku u 

Encore kliknite YES, kao bi se novi dizajn učitao u Encore (vidi sliku 61). 

U project prozoru postoje tri datoteke (vidi sliku 60). U Type koloni možemo vidjeti što označava koja 

datoteka. Kao i u Premiere-u, svaki video mora imati svoju vremensku liniju (Timeline). Na drag-and 

drop način povucite Timeline datoteku na „pusti film“ text. Sada ste napravili poveznicu, te kad netko 

klikne na „pusti film“ pokrenut će video. 

Ako želite ubaciti dodatni meni Izbor scena, u Resource central trebate pronaći drugu verziju već 

odabranog menija. Obično svaki meni ima dvije verzije: Menu i Submenu. Submenu označava verziju 

sa prozorima koja služi za Izbor scena. Nakon što ste skinuli Submenu verziju s interneta, dvaput 

kliknite na nju u project prozoru, te je također možete grafički prilagoditi u Photoshopu. Tekst koji je 

nepotreban (primjerice Next, Previous) možete jednostavno obrisati. 

Sad je potrebno dodati scene (chaptere) u vremenskoj liniji. Oni služe kako bi gledatelji mogli 

jednostavnije premotati odnosno pronaći određene dijelove videa. Otvorite Monitor prozor u sredini, 

te vremenskim klizačem pronađite točke koje želite da budu scene na videu. Za svaku točku kliknite 

na Add Chapter ikonu (vidi sliku 62). Također, desnim klikom na mjesto iznad mjesta gdje se nalaze 

chapteri, možemo odabrati Add Chapter Points at Intervals za automatsko dodavanje chaptera. Sada 

odaberite jedan chapter, te ga na drag-and-drop način povucite u prvi prozor u Submenu. Ponovite 

za druga dva prozora.  Sada bi trebali imati situaciju kao na slici 63. 

Kako bi povezali tekst „Povratak u glavni izbornik“ sa prvim menijem, potrebno je iz Project prozora 

na drag-and-drop način povući Menu datoteku na taj tekst. Na isti način potrebno je povezati „izbor 

scena“ u prvom meniju sa Submenu datotekom.  

Sada je potrebno odrediti što će se prvo pokrenuti kada se DVD medij ubaci DVD u player. U 

srednjem dijelu programa otvorite Flowchart prozor. Povežite DVD ikonu sa Menu ikonom (vidi sliku 

64). Tako će se prvo prikazati meni koji gledatelju omogućava odabir cijelog filma ili pojedinačnih 

scena. Također povežite Sequence 01 ikonu sa glavnim menijem (vidi sliku 65), kako bi se po 

završetku prikazivanja filma, player vratio na početni meni. 

Prije snimanja na DVD možete provjeriti kako će sve izgledati pomoću Preview ikone koja se nalazi 

desno od PS ikone u gornjem desnom kutu. 

Snimanje na DVD 

U lijevom gornjem kutu otvorite prozor Build. Odaberete Format: DVD, Output: DVD Disc (također je 

moguće odabrati i DVD Folder ili DVD Image te kasnije video i audiodirektorije snimiti pomoću Nera i 

sl.)  Pod Name upišite ime DVD-a. Za start snimanja kliknite na Build tipku u gornjem desnom kutu 

(vidi sliku 66). 

Za vježbu: 

Izradite DVD sa menijem za film sa tri chaptera uključujući i meni za izbor scena. 

 


